ECE 332 — Embedded Systems Lab

Lab 1: Using NIOS Il processor for code execution on FPGA



Objectives

» |[ntroduction to Altera tools
« Walk through from project creation to chip configuration (Lab1-Part I)

= |nstructions to get started with Part



Tools

= Quartus Prime
 FPGA development: Design, simulation, synthesis and download

= QSYS
« Build target QSYS system

« Based on a Processor-core (NIOS Il processor), you can add other peripherals (e.g.
Parallel 10, Ethernet Controller, Serial Ports, etc.)

= NIOS Il Software Build Tools for Eclipse

« Software platform for developing programs



Lab1 Objectives

= Partl:
« Display “Hello, world” in your debug console from NIOS II

= Part2:

« Implement a counter program and display the output on the LED, and the seven
segment display.



New Project Creation

= Open Quartus Prime, and select
file -> New Project Wizard...

» Specify a working directory and
name your project

 NOTE: Make sure your working
directory contains no white-space.
(This will cause problems later
when trying to compile your project
from the QSYS)

% New Project Wizard

Directory, Name, Top-Level Entity

at iz this project?
| proj_hello |D

What iz the name of the top-level design entity for thiz project? This name is case senzitive and must exactly match the entity name in the design file.
| proj_hello |D

|Use Existing Project Settings...

<Back | [ Mext= || Fmsh || cancel || Hep




FPGA Selection

= Select Cyclone V in the drop-
down box labeled “family”. We
will be using device
SCSEMASF31Co6.

= Click finish. All necessary
project parameters have been
configured.

Ok New Project Wizard

Family, Device & Board Settings

Device Board

Select the famity and device you want to target for compilation.
“ou can install additional device support with the Install Devices command on the Tools menu.

To determine the wersion of the Quartus Prime software in which your target device is supported, refer to the Device Support List webpage.

Device family Show in “Available devices' list

Eamily: | Cyclone V (E/GX/GT/SX/SE/ST) =] || Package: | e =
Devices: | Al =i | Pin count: |Any - i

Target device Core Speed grade: |Any - I
Auto device selected by the Fitter Mame fitter: |

@ Specific device selected in "Available devices' list Show advanced devices

Other: nfa

Available devices:

Name Total I0s GPIOs GXB Channel PMA GXB Channel PCS F
SCSEMASF31AT 457 457 o o o

A A O T
SCSEMASF31CT 457 457 o 1] 0
SCSEMASF31C8 457 457 o ] 0
SCSEMASF3MIT 1.1V 457 457 o 0 L
= — = = —— = i =

<Back | [ Mext= || Emsh || cancel || Hep




Using the QSYS System

 SOPC Builder (System on a Programmable Chip Builder) is software made
by Altera that automates connecting |IP cores to create a complete system
that runs on any of its various FPGA chips.

= Qsys is the next-generation SOPC Builder tool powered by a new FPGA-
optimized network-on-a-chip (NoC) technology.

» Open Tools -> Qsys to start the system, save the system with the same
name as the Top Level entity.


https://en.wikipedia.org/wiki/Altera
https://en.wikipedia.org/wiki/Field-programmable_gate_array

Launching QSYS

File Edit Miew Project Assignments Processing | Tools  Window  Help

D [ Q o Dj n .—I) C i proj_nello Run Simulation Tool
—— Generate Simulator Setup Seript for 1P

roject Navigator % Hierarchy
& Launch Simulation Library Compiler

Entity instance %&. Launch Design Space Explorer I
% Cyclone V; SCSEMASF31C8
® proj_hello .!rm @ TimeQuest Timing Anatyzer
Advisors 3

<% Chip Planner
@ Design Partition Planner
Metlist Viewers 3

SignalTap Il Logic Anatyzer

nufly

&  [n-System Memory Content Editor

. Logic Anahyzer Interface Editor
In-System Sources and Probes Editor
SignalProbe Pins...

Programmer

9
#b  JTAG Chain Debugger
9

Fault Injection Debugger

System Debugging Tools »
asks E Compilation

Task

¥ P Catalog

Mies Il Software Build Tools for Eclipse
w [ Compile Design

» P Analysis & Synthesiz

Tcl Scripts...
> B Fitter (Place & Route) F 4 nts
> P Asszembler (Generate programming files ) Customize. ..
» P TimeQuest Timing Analysis Options...

License Setup...

> P> EDA Netiist Writer
ik Install Devices...

B Edit Settings

& Program Device (Open Programmer)



QSYS Screenshot

ECE 332

sa Qsys - unsaved.qsys* (C\altera_lite\16.0\unsaved.qsys)

- O X
File Edit System Generate View Tools Help
t: System Contents 53] Address Map &2 | Interconnect Requirements &3 i m|
= S d
|4 processo « W0 system: unsave
Project # |Use  comn.. Name Description Export Clock Base
New Component... o B dk_0 Clock Source
Processors and Peripherals % o in Clock Input clk exported
B Embedded Processors m dk_in_reset Reset Input reset
Mios II (Classic) Processor : dk Clock Output k0
S B ios 11 Processor = -
[=hHard Processor Systems % clk reset JEESELAEi
Arria V{Cyclone V Hard Pros -
. x
Library
£ >
[ New... | [Edit.. [ o Add... |
L, Her Device F &% = mf|m|
M unsaved [unsaved.gsys*]
- clk
b= reset
Ik dk 0
£ >
= it T W current filter:
==
Type Path Message
£ >
0 Errors, 0 Warnings | Generate HOL... | | Finish |

Embedded Systems Laboratory




Adding NIOS Il Processor

#a Osys - unsaved.qsys™ (Chaltera_lite\16.0\unsaved.qgsys) — O x
File Edit System Generate View Tools Help
AddressMap  i% | InterconnectRequirements 5% o
S S I i e 0 B e % |« W system:unsaved Path: nios2_gen2_0
%&  Nios II Processor
phomgiaryfibey I Conmeratn Use  Connections Name Description Export Clock Base
= = ] o dk0 [Clock Source
[l om st bl ET =1-Processors and Peripherals % o~ dkin (Clock Input ke exported
Select
e [ Eesan e 8 Fimiyecklest Proce ey =) o4 dkn_reset Reset Input reset
ey - = dk (Clock Output dk 0
L) dk_reset Reset Qutput
- Hard Processor Systems
v netructon_mastar Nios I1/e Nios II/f e ) a
e At sommery [Resource optimced 32 wISC lormance-opinuted 32 bt RISC e Arra V[Cycone Viard Prod || ¥ ok (Clock Input uncannected
e e et Features [17AG Debug 774G Debug e ! > reset Reset Input [ch]
o ECC RAM Protection Hardware Fuitiply [Divide -
= Data Caches Library data_master |Avalon Memory Mapped Master [ck]
Tightly-Coupled Masters
ECC RAM instruction_master \Avalon Memory Mapped Master [ck]
External Interrupt Controlier
Shadow Register Sets. irq Interrupt Receiver [ck]
HPU
HHY < > debug_reset_request  [Reset Output [ck]
[Ra Usage |2+ Ootons 2 + Opbans debug_mem_slave \valon Memary Mapped Slave [ck] 0x08!
New... Edit,.. | = Add. custom_instruction_m... [Custom Instruction Master
!,.‘ EM Device F % = .
] unsaved [unsaved.gsys*]
H-m= dk
B reset
I d
B Connections
< >
) Error: mios2_gen2_ Reset save i ot specified, Plesse select the reset sove. bl T W carent fiker:
) Ervor: mins2_aen2_: Plesse select the m
Type Path Message
=[] 4Errors
(%] unsaved.nios2_gen2_0|Reset slave is not specified. Please select the reset slave
Canest [x] unsaved.nios2_gen2_0|Exception slave is not spedified. Please select the exception slave
%] unsaved.nios2_gen2_0|nios2_gen2_0.dkmust be connected to a dock output
-~ S e
< >
4Errors, 0 Warnings GenerateHDL.. || Finish |




Adding JTAG UART

= Next, we will be adding a J

UART module, found under Serial.

& JTAG UART- jt

“ JTAG UART

Megators” altera_avalon_jtag_vart

| Block Diagram

[] show signals

|~ write FIFO (Data from Avalon to JTAG)

Buffer depth (bytes): |g4 |

1RQ threshold: -

E\ralon jtag_slave
javalon

aftera_avalon_jtag_uart

jtag_uart O
[] Construct using registers instead of memory blocks
Ik : i
S intemupt [~ Read FIFO (Data from JTAG to Avalon)
L S

Buffer depth (bytes): ]54 i ‘

IRQ threshold: Es

[[] Construct using registers instzad of memary blocks

/4, Warning: jtag_uart_0: JTAG UART IP input dock need to be at least double (2x) the operating frequency of JTAG TCK on board

#a Osys - unsaved.qsys™ (C:\altera_lite\16.00unsaved.qsys) = [m] x
File Edit System Generate View Tools Help
4% [P Catalog  £2 AddressMap 9% | InterconmectRequirements % |
& %« W system: unsaved
Project # |Use  Connections Name Description Export Clock Base
1 New Component... L] = dk_o Clock Source
-Basic Functions X =g dk_in Clock Input il exported
=] El;d?fs and ;dam"’;s = o dkn_reset Reset Input reset
lemory Mappe:
® ITAG to Avalon Mas = 5 flock Dxeat k0
(1 Simulation; Debug and Verificati = dk_reset Reset Qutput
£ Debug and Performance Bl nios2_gen2_0 Nios IT Pracessar
® Altera Soft Core T/ e dk Clock Input
i ® Altera Virtual JTAG ¥ reset Reset Input [ck]
E-Interface Protocols data_master Avalon Memory Mapped Master [ck]
E Sér\al instruction_master Avalon Memory Mapped Master [ck]
" i irg Interrupt Receiver [clk]
librarvy
< > debug_reset_request Reset Output [ck]
debug_mem_slave ‘Avalon Memory Mapped Slave [ck] 0x08
New... ] Edit... | == Add. ‘ custom_instruction_m... |Custom Instruction Master
- = jtag_wart_0 G UART
4 dk Clock Input
Di 70
= == reset Reset Input =)
q;g unsaved [unsaved.gsys*] avalon_jtag_slave Avalon Memory Mapped Slave [cl]
i g Interrupt Sender [kl
B reset
o= ck o
Lk jtag_uart_0
B nios2_gen2_ 0
[ Connections S &
il ¥ ¥ current fiter:
Type path Message
EQ & Errors
[x] unsaved.nios2_gen2_0|Reset slave is not specified. Please select the reset slave
0 unsaved.nios2_gen2_0 |Exception slave is not specified, Please select the exception slave
%] unsaved.nios2_gen2_0|nios2_gen2_0.clk must be connected to a dock output
- = e i G =3 h
< >
6 Errors, 3 Warnings Generate HDL... | | Finish




Adding On -Chip Memory

|~ Memory type

Type: RAM (Writable)

[] Dual-port access

Read During Write Mode: DONT CARE
Block type: AUTO

Slave 51 Data width: 32
Total memory size: 4095 bytes

mizZe mer

|~ Read latency

Slave 51 Latency: 1

Slave 52 Latency: i
Fl_lt_)_l':i_,-'R.ﬂM Memory Protection

Reset Request: Enabled -

|* ECC Parameter

Extend the data width to support ECC bits: |pisabled -

|~ Memory initialization

Initizlize memery content

[] Enable non-default initialization file

Type the filename {e.q: my_ram.hex) or select the hex file using the file browser button.

User created initialization file:

[] Enable In-System Memary Content Editor feature

Instance ID: MOM

Memory will be initialized from unsaved_onchip_memory2_0.hex

| -l
+- W reset

Bk ck 0

sa Qsys - unsaved.qsys*™ (C:haltera_lite\16.0\unsaved.qsys) — [} *
File Edit System Generate View Tools Help
P Catalog 2 I& t: System Contents 2% | AddressMap % | InterconnectRequirements &2 o =
, onchi x| | . System: unsaved. Path: jtag_vart_0 . .
[Project 1| % [use  Connections Name Description Export Clock Base
-8 pew Companent... 4 o din Iclack mput |eik |exported | A
-Basic Functions b4 D—I dk_in_reset lReset Input |reset |
=HOn Chip Memary = dk Iclock Output ldk_0
: = | clk__reset %Rfaset Output
|Library | = | = DQ nios2_gen2_0 ENIDS II Processor | |
| dk |Clock Input |\unconnecteg
| reset |Reset Input |[clk]
I data_master Avalon Memory Mapped Master E[clk]
i instruction_master Avalon Memory Mapped Master |[clk]
irg Interrupt Receiver ;[clk]
debug_reset_request  [Reset Output |[ctk]
| ¢ > | debug_mem_slave Avalon Memory Mapped Slave ?[clk] | Ox!
o ) custom_instruction_m... |Custom Instruction Master |
New... | | Edit & Add... B jtag_uart_0 |TTAG UART
dk |Clack Input |unconnectea
) - reset [Reset Input |[ck]
__lj“_‘_ i %J ech = =i I:I_ avalon_jtag_slave Avalon Memory Mapped Slave E[dk]
IQ unsaved [unsaved.gsys*] | irq Interrupt Sender ;[dk]

'On-Chip Memory (RAM or ROM)

iCIock Input




Clock and Reset Connections

Use

Connections

Mame
B ck 0
ck_in
dk_in_reset
dk
ck_reset
=] Q nios2_gen2_0
clk
reset
data_master
instruction_master
irg
debug_reset_request
debug_mem_slave
custom_instruction_m...
B jtag_uvart 0
dk
reset
avalon_jtag_slave
irg
B onchip_memory2_0




Other Connections

Use Connections Mame
B dk 0
C— dk_in
C— dk_in_reset
- dk
% ck_reset
B 1] nios2_gen2_0
L dk
[ ¥ reset
— data_master
—T instruction_master
— irg
rm—, debug_reset_reguest
- debug_mem_slave

custom_instruction_m...
B jtag_uart_0

L dk

* * reset

[ avalon_jtag_slave
—1— irq

B onchip_memory2_0
* dk1

—r— 51




Assigning Reset and Exception Vectors

sn Osys - unsaved.gsys® (Chaltera_lite' 16.00unsaved.gsys)
File Edit Systern Generate View Tools Help

Upgrade IP Cores...

Assign Base Addresses

Assign Interrupt NMumbers

Assign Customn Instruction Opcodes

E'"E-?Sl Create Global Reset Metwork
Show System With Osys Interconnect
Remove Dangling Connections

Import Interface Requirements...

'!'_ System Contents Q AddressMap  £9 | Interconnect Requrements &%

==
% & W system:unsaved Path: nios2_gen2 0
# |Use  Connections Mame Description Export Clock Base End RQ Tags Opcode Mame
.| B dk_0 (Clock Source
X (=8 ck_in (Clock Input ok exported
B O~ dkn_reset Reset Input reset
s ck (Clock Output ck_0
de_reset Reset Output
o o 18 nios2_gen2_0 Nios T Pr
v ck Clock Input dk_o
b 4 reset Reset Input [ck]
— data_master \Avalon Memory Mapped Mastsr [ck]
instruction_master \Avalon Memory Mapped Master [ck]
irq Interrupt Receiver [ck] IRQ O IRQ 31
— debug_reset_request  |Reset Output [clik]
debug_mem_slave \Avalon Memory Mapped Slave [ck] 0x2800 Ox2EEE
custom_instruction_m... [Custom Instruction Master
B jtag_uart_0 ITAG UART
ck (Clock Input clk_0
reset Reset Input. [clk]
avalon_jtag_slave \Avalon Memory Mapped Slave [ck] 0x3000 0232007
irq (Interrupt Sender [ck]
B onchip_memory2_0  (On-Chip Memary (RAM or ROM)
ck1 (Clock Input clk_0
s1 \Avalon Memory Mapped Slave [ck1] 0x1000 Ox1E£f
reseti Reset Input [c1]
e At W W current filter:
[H ==
Type Path Message
@& | 11nfo Message \
@ |nnsaved.itag7uart7:) ‘ma UART IP input dock need to be at least double (2x) the operating frequency of JTAG TCK on board
< >
Generate HDL... | | Finish




Adding system ID

= Systermn |D Peripheral - sysid_gsys 0

“ System ID Peripheral

Megators® altera_avalon_sysid_gsys

x

4

4
sk | S—
[7] 5how signals 32 bit System ID: |0,00000010]
sysid_gsys_0
Please use hexadecmal numbers only in System ID.
ek
eset "
ontrol_slave |
altera_awvalon_sysid_gsys

@ Info: sysid_gsys_0: System ID is not assigned automatically. Edit the System ID parameter to provide a unigue ID
@ Info: sysid_gsys_0: Time stamp will be automatically updated when this component is generated.

ECE 332

Use
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Connections
o
o
7
—_——————
L .
L .
T
—
—
.
L .
L
L .
—
L
- -
L
L
»

Mame

B clk 0
dk_in
dk_in_reset
dlk
ck_reset

B I nios2_gen2_0
dlk
reset
data_master
instruction_master
irg
debug_reset_request
debug_mem_slave

custom_instruction_m...

E jtag_wart_0
dlk
reset
avalon_jtag_slave
irgq

B onchip_memory2_0
ck1
51
resetl

E sysid_gsys 0
clk

reset

control_slave

Description

Clock Source

Clock Input

Reset Input

Clock Qutput

Reset OQutput

Mios II Processor

Clock Input

Reset Input

Avalon Memory Mapped Master
Avalon Memaory Mapped Master
Interrupt Receiver

Reset Output

Awvalon Memory Mapped Slave
Custom Instruction Master
JTAG UART

Clock Input

Reset Input

Avalon Memory Mapped Slave
Interrupt Sender

Cn-Chip Memary (RAM ar ROM)
Clock Input

Avalon Memory Mapped Slave
Reset Input

System ID Peripheral

Clock Input

Reset Input

Avalon Memory Mapped Slave

16



enerating HDL

sn Osys - unsaved.qsys™ (Chaltera_litel16.0\unsaved.qsys)
File Edit System Generate View Tools Help

Generate HDL... —dml iz

P ———r—rv— o x
Generate Testbench System... {5 £t S gt yeu s s i _ i
— S (il L e ||t | [T S | atmemren | inmearmec e 2 -
| A - 151 | =
| | : 1T e m——
|~ onchi Generate Example Design... » b4 .i?, LR
: - - N i [ o = Y o e = i e
= L] B dko foock saurce
S x ol n ftrmn o i
Project Show Instantiation Template... x S [~
g —— & [clack cusur o
: 3 ioarars - s
“’ New Compormerit... el PP x — e Reset ot
& : 0 Pracessors and Peraneras =] B niws2 gen2 0 faos I Process
[=-Basic Functions e z < ot o
& 1 3
: e T ey f
[=H-0n Chip Memory brary s o ooy ol s
P % Basc Furcions ) [internuot Recemer [=5) e of RO 317
| e ki o
| e st o o
e oo . oo e
=] B jtag_vart 0 |7TaG AT
= Bt las
ag resst Resstirput ]
Library e o S e cesnen caoes
L = L [internuot Sender fe}
a ) ooy memary2L8 P oo 20
Wew... | [k oo | HH——| " foock gt ko
i RO oy
T T resatt Peset gt el
=] B sysid_asvs 0 [Svstem ID Perichersl
E:-;:h-u. [prai_hella geyal & ok Input. k0
bl
G T
s
= I sz _gen2 0
@ onchio_memory2 D
& 0 spd_cmys 0
it
= ‘
- I Connections 4 V¥ Current filker:
el ==
ot e ‘
=0 |2 sz
@ [pron hellogtng uart 6 178G Ui B imput vk nmed e st ol (1) the speraing Faqumncy of TG 106 o b
0 [pror hebenynd s o 521t s sy, 3 i et s e |
| @ [pron_helloyed_asys_0]fime rtamo il be sty dated uben the comporert x geveraied |
(
: R\
T ] [
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Tutorial: Programming the FPGA

(_# Quartus Prime Lite Edition - C:/altera_lite/16.0/proj_helle - proj_hello

| BaCk tO Quartus Prime File Edit Miew @ Project Assignments Processing Tools Window  Help
° Add ‘the QIP flle to the prOJeCt Ors dl - ~ Add Current File to Project

1 H H Project Mavigator . Ehanﬁqed
in Quartus, it contains the s P
Verilog files generated by Capy Proect..
QSYS Clean Project...
. = Archive Project...
 Now select Processing -> et At P
start -> Start Analysis & et Delboee
Synthesis_ Export Database..
« A number of warnings will i
appear during the CheCk Generate Design Partition Scripts...
ThlS |S normal Generate Tcl File for Project...

Generate PowerPlay Early Power Estimator File
Upgrade IP Components...

Organize Quartus Prime Settings File

-]

Set as Top-Lewvel Entity Ctri+Shift+]
Tasks

Hierarchy k




Quartus: Analysis & Synthesis

Gb Quartus Prime Lite Edition - C+/altera_lite/16.0/proj_hello - proj_helle

Fie Edt View

OrFd 00D C | e

Project  Assuments  Processing  Jools  Yindow  Help

SESLBrEY RO DAV @

Project Navigator | iy Mierarchy @ Compiation Report - prol_heso =] |P catang pex
Entity-Instance Table of Contents e ™ X =
P P o Sy Fiow Status In progress - Wed Dec 09 16:32:51 2020
A - X : Fow Quartus Prime Version  16.0.0 Budd 211 04/27/2016 SJ Lite Edition v i staled P
5 & pro_helio Settings B Howo proL el ~ Project Directory
BE :w Non-Defaut Global Settings ToplevelEntty Name  proj_hello > Basic Functions
B Fuwu Elspged Tima Famiy Cycione > DSP
E low O Summary > ‘nterface Protocols
B Fw,’?’ > Memary interfaces and Controbers
> ::umssynmgh > Processors and Perpherals
Tow Messages > Universty Program
@ Fow Suppressed Messages ~ Library
» Basic Functions
> OsP
> interface Profocols
@ Search for Parines P
€ >
Tasks
Tosk Time
Compile Design
P Anatysis & Synthesis 00:00
» > Fiter (Place & Route)
» P Assembler (Generate programming fles)
» P TmeQuest Timng Analysis
» = EDA Netist Writer
W Edi Settings.
a Program Device (Open Programmer)
< >||¢ > + am.
x el
5| A ol |"" «<Filees>
2 Type ID  Message Ll
@ 12128 €laborating entity "proj_hello_irq_mapper” for hierarchy "proj_hello_irq_mapper :irq_mapper"
@ 12128 Elaborating entity "altera_reset_controller” for hierarchy “altera_reset_controller:rst_controller”
@ 12128 elaborating entity "altera reset_synchronizer” for hierarchy "altera reset_controller:rst_controller|alterareset_synchronizer:alt_rst_sync_uql”
@ 12128 Elaborating entity “altera_reset_synchronizer” for hierarchy “altera_reset_comtroller:rst_controller|altera_reset_synchronizer:alt_rst_req.sync_ugl”
@ 11170 start IP generation for the debug fabric within s1d_hub.
@ 11172 2020.12.09.16:33:06 Progress: Loading s51d32f20633/alt_s1d_fab_wrapper_hw. tcl
@ 11172 Alt_sld_fab.alt_sld_fab: sLo fabric agents which did not specify prefer_host were connected to JTAG
@ 11172 Alt_sld_fab: cenerating alt_sld_fab "alt_sld_fab” for QUARTUS_SYNTH
v
o >
System  Processing (155)

0% “§ 00:00:18



Assigning CLK and Reset Pins

= The pins assignments can be done using Assignment Editor in Assignments ->
Assignment Editor

* Find the entry corresponding to the clock, assign PIN_AF14 to it. doing so will
connect the clock in our design to the 50 MHz oscillator on the DE1-SoC board.

= Now assign the reset input signal to any of the SW[x] pins. This will connect the
reset signal to one of the switches found on the DE1-SoC board.

= Now select Processing -> Start Compilation. If compilation is successful, a
programming file to be written to the FPGA will be generated.



Assigning CLK and Reset Pins

G Cluartus Prime Lite Edition - Ci/faltera_lite/16.0/proj_hello - proj_hello
File Edit View Project  Assignments Processing Toolz Window Help

— ] : t*
O dl«0n®

4% Cyclone V: SCSEMASF31C ‘&
5 & proj_helo ©F

Project Mavigator

)

»o

Device...

Settings. ..

Assignment Editor

Pin Planner

Remove Assignments...
Back-Annotate Azsignments...
Import Assignments. ..

Export Assignments...
Azsignment Groups...

LogicLock Regions Window

De=ign Partitions Window

CtrieShift+E
Ctri+Shift+4
Ctri+Shift+N
Q Compilation Report - proj_helio B & Assignment Editer*
=<News> ¥ Fiter on node names: | *
Status From To Aszsignment Name Value Enabled Entity Comment Tag
1) ! M Ves
2 <<NeW>> <<New>>= <<EW>>
Node Finder

Altl
Alt+Dr




Assigning CLK and Reset Pins

& Node Finder >
Mamed: | * \,ll List ||2|
Options
Fitter: |F‘jrts: all v| i Customize... i
Look in: ||pr|:rj_helll:|-| v| !_| [] Include zubentitiez  [~*] Hierarchy view
Watching Modes: B = Modes Found:
MName Aszsignments v Narme Aszsignments
>
>
o
<<
< »| |« >
oK | Cancel |
<EeWE= T H Fiter on node names; | *
e
status From To Assignment Mame Value Enabled Entity Comment Tag
v T L o cx Location :

o _ﬂ,_ reset reset n  Location

CINEW=S

[TE RN L R

PIN_AB12 " Ves

==MEW == ZZNEW ==



Compiling

G Quartus Prime Lite Edition - C:/altera_lite/16.0/proj_hello - proj_helio

Fle Edt  Yew Project Assgnments Processing Jools Yndow Help

NRH OO0 0 C)

SEELBrFES OAVE:

Project Navigstor CvHersrchy vz 98 x Complaton Repart - proL_heto
Entty-nalance Table of Contents e
In progress - Wed Dec 09 17:12:01 2020
clone V- SCSEMASF31C6 Flow Summary
& Cr % : Pl 16.0.0 Build 211 04272016 SJ Lite Edition x -‘ nsiaked P
e Er Mn-DewMGwsm e v Project Directory
EFW“ i ISetiyn: proj_helo > Basic Functons
low Elspsed Cychne v
> DSP
;E :wus Summary SCSEMASFI1CE > lnterface Profocols
8 bwi.?q Final > Memory interfaces and Controbers
> [ Anslyss & Synthesis x > Processors and Perpherals
» ::lﬂ!r 5 > Unmersiy Program
low Messages <
~ Library
sprassad Messa Total virtual pins. 0
© Fowsy i Total block memory bits 44032 > Basic Functons
Total DSP Biocks. 0 > DsP
Total HSSIRX PCSs 0 > interface Profocols
Total HSSIPMA RX Deseriaizers 0 @ search for Pariner B
Total HSSITX PCSs U]
Total HSSI PMA TX Serisizers o
Total PLLs 0
< > Total DLLs ]
Placs & Route}
¥ P Assembler (Ganerst 00:00:00
3 P Timetues 00:00:00
> 00:00:00
B Eorsemngs
&) Program Device (Opan Programmer)
<3 >z >
= P =
ol @& @& A [V e 80Fnd. |
Bype 10 message ~
T © 332143 No user constrained clock uncertainty found in the design. calling “derive_clock_uncertainty”
© 332123 periving Clock uncertainty. Please refer to report_sdc in TimeQuest to see clock uncertainties.
@ 232129 petected timing requirements -- optimizing circuit to achieve only the specified requirements
> @ 332111 Found 1 clocks
» @ 176235 Finished register packing
@ 11798 Fitter preparation operations ending: elapsed time is 00:00:12
@ 170189 Fitter placement preparation operations beginning
@ 14951 The Fitter is using Advanced Physical optimization.
v
< . >
System (%)  Processing (205)

27% 3,6 00:0049




Programming the FPGA

Select Tools -> Programmer. Now, select Auto detect, a new dialogue
box opens up, choose “5CSEMAS”, you can find two entries, Right click
on the SCSEMADS entry, change the file to the target SOF file. Be sure that
DE1 SoC is connected to the computer via the provided USB cable.



Programming the FPGA

(% Quartus Prime Lite Edition - Ci/altera_lite/16.0/proj_hello - proj_hello
Tools Window  Help

File Edit Wiew Project Assignments Processing

D @400 o

Project Navigator

[ % Hierarchy

Entity:Instance

% Cyclone V: SCSEMASFI1CE
5 % proj_helo o'

£
Tasks | Compiation
Task
v P Compie Design
E¥ 4 » P Analysis & Synthesis

» P> Fitter (Place & Route)

> P TimeQuest Timing Analysis

> P EDA Netlist Writer

W Edit Settings

5 P Assembler (Generate programming files)

H ¢

P

IR B <

cre

W = 8

Run Simulation Tool

Generate Simulator Setup Script for IP...

Launch Simulation Library Compiler
Launch Design Space Explorer Il

TimeQuest Timing Analyzer
Advisors

Chip Planner
Design Partition Planner

Netlist Viewers

SignalMap Il Logic Analyzer
In-System Memory Content Editor
Logic Analyzer Interface Editor
In-System Scurces and Probes Editor
SignalProbe Pins...

JTAG Chain Debugger

Fault Injection Debugger

System Debugging Tools

P Catalog
Nios Il Software Build Tools for Eclipse
Qsys

Tcl Scripts...
Customize...
DOptions...

License Setup...

Install Devices...

Programmer - C:/altera _lite/16.0/proj_hello - proj_hello - [Chaind.cdf]*
).
Fle Edt \iew Ppocessng Jools ndow Hep

o Hrawars setup..| [BESeC LSE1

Mode: [JTAG
{m] 5P 1o alow
Y File Device: Checksum Usercoce Program’ Verify Biank- Examne Security  Erase BP
PR s Configure Check Bt cLAWP
oSG <nones SOCVAPS 00000000 <nones
| output_flesiprof_helo sof  SCSEMASF31 00FSSAS2  OOFSSAS2 =
5 Auto Detect
X Delete
™ Addfie.
P Change Fae..
e Save Fie
F* Add Device.
thue
1t pown

SOCVHPS SCSEMASF31




Tutorial: Using the NIOS |l IDE

* Now that you have successfully developed an QSYS system, we will write
a very simple program to run on our new processor.

» Select Tools -> NIOS Il Software Build Tools for Eclipse.

» Create a new workspace. Make sure that there are no spaces in path
directory names.

= Disable Anti-Virus for NIOS to detect connected board

» Make sure that your reset switch is logic HIGH (Reset Input is active when
it is low)



Tutorial: Using the NIOS Il IDE

(T Quartus Prime Lite Edition - Ci/altera_lite/16.0/proj_hello - proj_hello
File Edt View Project Assignments Processing @ Tools Window Help

Ord

7 | |proihelo

Project Navigator | a% Hierarchy

Entity:Instance
4% Cyclone V: SCSEMASF31CE
> &% prolhelo oy

<
Tasks | Compilation
Task
" ~ P Compile Design
1" 4 » P Analysis & Synthesis
v » [ Fitter (Place & Route)
v 3 P Assembler (Generate programming files)
v 4 » P TimeQuest Timing Analysis
v » [ EDA Netlist Writer

W Edit Settings

ECE 332

G ¢

Em 3 %

cre

% W

Run Simulation Tool

Generate Simulator Setup Script for IP.
Launch Simulation Library Compiler
Launch Design Space Explorer I

TimeQuest Timing Analyzer
Advisors

Chip Planner
Design Partition Planner

Netlist Viewers

SignalTap Il Logic Analyzer
In-System Memory Content Editor
Logic Analyzer Interface Editor
In-System Sources and Probes Editor
SignalProbe Pins.

Programmer

JTAG Chain Debugger

Fault Injection Debugger

System Debugging Tools

IP Catalog

Nios Il Software Buid Tools for Eclipse
Qsys

Tcl Scripts..

Customize...

Dptions...

License Setup..

Install Devices.

= Nios |l - Eclipse

File Edit MNavigate Search Project Miosll Run Window Help

e ETE R0 -iE

= O X

| o | (@i

fib Project Explorer 2

BS

0 items selected

| &

E’u Problems 2« T

O items

=

] B Outline 52 =5
-
@
An outline is not available.

Description

Resource

Path

Location Type

Embedded Systems Laboratory

27




Tutorial: Using the NIOS Il IDE

= Select File -> New -> NIOS |l e i - |
Application and BSP from template. A  [Fosm o wssiens £ i e
new dialogue box should open. | [V O
: Close Al Crls Shifts W ;‘:1':*"“3”
« A variety of project templates are e A
provided as a starting point. We will = ol
be using the “Hello World Small” —
template. 4| Rename.. 7
& Refresh F5
Convert Line Delimiters To ¥
= In order to develop a NIOS project, the e
IDE needs a .sopcinfo file that Restar
indicates various peripherals unique to |
our design. Properties
Exit




Tutorial: Using the NIOS |l IDE

= Nios Il Application and BSP from Template m|

Nios Il Software Examples

Create a new application and beard support package based on a software example template

Target hardware information

SOPC Information File name: | Chaltera_lite', 16.0\proj_hello.sopcinfo

CPU name: nios2_gen2 0 )

Application project

Project name: | proj_hello

[~ Use default location

Project location: | Chaltera_lite\16.00software\proj_hello

Project template

Templates Template description

Blank Project A | | Hello Warld Small prints ‘Hello from Nios |I' to STDOUT. The »
Board Diagnostics project occupies the smallest memory footprint possible for
Count Binary a hello werld application.

Float? Functionality

Float2 GCC This example runs with or without the MicroC/05-11 RTOS
Floatd Performance and requires an STDOUT device in your system's hardware,
Hello Freestanding

Helle MicroC/O5-11 For details, click Finish to create the project and refer to the
Hello World readme.txt file in the project directory.

Memory Test The BSP for this template is based on the Altera HAL

Memaory Test Small ¥ | | operating system with reduced code footprint.

£ > W

@) < Back Next > Cancel




Tutorial: Using the NIOS |l IDE

= You should now be looking at a window like this:

& Mios |l - proj_hello/hello_warld_small.c - Eclipse
File Edit Source

Refactor

Event loop newver exits. */
while (1):

return 0;

s Bl Console 2
COT Build Conscle [proj_hello]

[proj_hello clean complete]

= O
Mavigate Search Project Niosll Run  Window Help
TSNS R e G O A I o
Quckicems || £ | [@ st
[ Project Explorer 52 = 5 [£] hello_world_small.c &2 = =l = outline 52 o]
(=] <ﬁ==‘=>| il =7 @ * "Small Hello World" example. [] ¥ B lﬂz ‘Q ‘3 @ “:HE
v == proj_hello 8 -
= #include "sys/alt stdio.h"
y B Inddes B1 sys/alt_stdio.h
; % :\yesiti:mwmld small.c Frntametng) v e
= e {
E :lei:clthls app alt putstr("Hello from Nipg II!\n"):
& Makefile =
readme.txt 7
P - proj_hello_bsp [proj_hello]

|t B-mi-= 0o

10:49:42 Build Finished (took 145ms)

Writable Smart Insert 2

2]




Tutorial: Using the NIOS |l IDE

= Check expected and connected system id are same:

= Run Configurations

= Mios Il - proj_hello/hello_world_small.c - Eclipse Create, manage and run configurations
File Edit Source Refactor Mavigate Search Project Niosll | Run | Window Help The expected Stdout device name does not match the selected target byte stream device name.
e o e TG B0 @ Run Ctrl+F11 CEX 5
% Debug E11 | L & B 5@ Mame: | proj_hello Mios || Hardware configuration
[t Project Explorer 52 BES | [ o | | type filter text || [B Project !fl. Target Connection . %% Debugger\i = Commoﬂ B Source]
v &5 proj_hello L e+ Application
y %: Binaries Run As » Z++ Remote Application
5 IjJ-i Includes Run mﬁgu[at‘m ! inch Group Device ID Instance ID Mame Architecture Refresh Connections
#: b . g S o 15 |l Hardware . . 1 e | T EE—— |
> (= obj Debug History » prej_hello Mios Il Hardware conl ERREReY I
» (= system 15 |l Hardware v2 (beta) | System ID Properties... |
» [ hello_world_small.c Debug As ? s 1l ModelSim
> ’ﬁ}? proj_hello.elf - [alteranios2/le] Debug Configurations... ¢ s Il ModelSim v2 (beta) Device ID system |D Properties b
|2 create-this-a jEAS. .2 ] Expected system ID base address: 0x0
I_' . pe % External Tools ¥
| & Makefile Expected system ID: 0x10
oy 2 wnIrIre (.
= proj_hello.map Connected system ID: 0x10
|Z| proj_hello.objdump e fo & .jdi files extracte Expected system timestamp: 1607622118
readmetxt } Connected system timestamp: 1607622118
y proj_hello_bsp [proj_hello] R
Close |
< >
< >
Appl Revert
Filter matched 8 of 8 items e o

@ Run I | Close




Tutorial: Using the NIOS Il IDE

= Under the “Project Explorer” tab,
right-click on the application. This
time select Run As -> NIOS |l
Hardware.

= This option will compile and write
the program to the on-chip memory
we specified in QSYS.

[ Project E

> [l

= proj_hella

MNew

Go Into

Open in New Window

Copy
Paste

Delete

Remove from Context
Source

Move...

Rename...

Import..
Export...

Build Project

Clean Project

Refresh

Close Project

Close Unrelated Projects

Build Configurations
Make Targets

Index

Show in Remote Systems view
Profiling Tools

Convert To...

Profile As

Debug As

Run As

Compare With

Restore from Local Histery...
Mios Il

Update Linked Resources
Run C/C++ Code Analysis

Tearmn

Properties

Ctrl+C
Cirl+V
Delete
Cirl+ Alt+Shift+ Down

F2

F5

Alt+Enter

5

rld"® example. []

o from Nigs II'\n"):

ver exits. */

nsole & El Prop

plete]

Ed (took 145ms)

i 2k ] ¥

1 Lauterbach |55
2 Local C/C++ Application
4 Mios || ModelSim

Run Configurations...




Hello From NIOS II!

@ Nios Il - proj_hello/hello_world_small.c - Eclipse — 5] x
File Edit Source Refactor Mavigate Search Project Miosll Run  Window Help

| o | @i

(5 Project Explorer 12 E%|® =0 | [@neo_word smallc | =0 Zomnex wEHALWWoeR =0
L
~ 15 proj_hello @] * "Small Hello World” example. [] ~ | U syy/alt stdio.h
> R Binaries & main():int
> Bl Includes #inclnde "sys/alt_stdio.h®
> @ obj
» = system “int main()
: iﬁ p',;,j'_he.@d,_[,“mw!] alt_putscr("Hello from Nies II!\n"):
gml:\ﬁ-lpp /* Event loop never exits. "/
2 while (1):
1 proj_hello.map
2 proj_hello.objdump retorn 0:
readme.txt ¥
> 5 proj_hello_bsp [prog_hells]
<

Nigs 11 Hardvare
Hello from Nies II!

ation - cabie: DE-50C on locakhost device ID: 2 instance ID: 0 name:

| writable | smartinset | 2:1
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Checkpoint: Lab1 (Part I)

= A NIOS system in the Quartus Prime QSYS

= Use the NIOS Il IDE to run a very simple C program on the system defined
in QSYS.



Part |l

= You will use external memory
* You will use other devices (LED, seven segment, and hex display.)
» Please read lab instructions on class website



Getting Started with Part Il (QSYS)

 Add the SDRAM
PLL to drive the
system

« Add the SDRAM as

the program
memory

* Add the required
P1Os and name

them appropriately

% Qsys - count_bin.qsys (C:\Users\ECS-ECELAB23\ Documents\ECE354 redesignicount_bin\count_bin.qsys)

=3 o X
File Edit System Generate View Tools Help
m - of o[ &5 systemcontents. 53 | adaressmap 51 [ intercomect Requrements 53 =
T x| & & |4 W system: count bin  Path: sdram_pl
Project F e Comnections Name. Desaripton Base End RQ Tags Opcode Name
8 New Companent. o -
& System x o
oy~ B ; O refreset
® g.;( Functions e
® =
Interface Protocols & H sdram_dk
Low Power | reset_source
& Memary Interfaces and Controlers >4 | B nios_cpu
(¥} Processors and Peripherals > - 3
(8- Qsys Interconnect — reset
 University Program _ data_master {Avalon Memory Mapped Master
—_— instruction_master {&valon Memory Mapped Master
S Emm— g (Interrupt Receiver IRO 0f IRG 31F—
debug_reset request  Reset Qutput
debug_mem_siave  Avalon Memory Mapped Slave 0x0800_0800 ox0B00_0£L£E
ustom_instruction_m... Custom Instruction Master
%] | © SDRAM Controlier
dk Input sdram_pll_...
reset Input e
sl Avalon Memory Mapped Slave (= ] 0x0400_0000 0x0722 g222
=g/ wire. it |sdram
MNew... | | Edt & Add., =] B jtag_vart |JTAG UART
ke (Clock tnput |sdram_pll_..
5 o reset Reset Input i)
- _ = = . avalon_jtag_slave :Avalm Memory Mapped Slave g Ox0800_1050 0x0808_1087
(2] :“:‘:‘lﬁ*j’é"‘"“-m“'q"" — Interrupt Sender ] =
e B timer Interval Tener
B0 leds dk IClock Input sdram_pll_...
(W sdram reset Input k]
) =a sdram_dk sl Avalon Memory Mapped Slave [k 0x0800_1000 0%0800_101£
(&= sdram_pll_ref _dk g : ‘Sender %) 0
(41 W= sdram pll_ref reset =] B button_pio [PIO (Paratel 1/0)
Eoon - —
_pio |
=i L et ret Resetinput 1 1 ]
O led_pio b e W W Current filter:
&I nios_cpu
- 102X [ -ogo
) seven_seg_pio
O tmer Type Path Message
& I Connectans =0 2 Info Messages
(1] | count_bin.button_pia|PIO nputs are nat hardwired in test bench, Undefined values wil be read from P10 inguts during smulation,
[ |count_bin.jtag_uart |TTAG UART P input dock nesd to be at least doupie (2+) the eperating frequency of JTAG TCK onhoard

PIQ inputs are not hardwired in test bench. Undefined values will be read from PIO inputs during simulal

0 Erors, 0 Warnings

Generate HOL....




Pin assignments viewed from Pin Planner

&% Pin Planner - C:/Users/ECS-ECELABZ 3/ Documents/ECE354_redesign/count_bin/count_bin - count_bin

Efe [Edt  Mew Processng Jools Jindow  Hep Search atera com ]
= e x Top View - Wire Bong
Cyclone V - SCSEMASFI1CE
k
a
W
X
b
B
Q
E:E
e Groups Report
& [Tasks 08 x
L ~ [~ Early Pn Planning -
B Earty P Panning...
2 P Run ¥O Assignment Analysis
$ B Export Pin Assignments
B Pin Finder.,
“ ~ [~ Highight Pins.
'x ] BB voBenks
o BB VREF Groups v
= < >
[ x| Hamea| -  Ja| eoe 1 IR | Fier Prs: a1 -
g Hode Name Direction Location VO Bank VREF Group Fitter Location VO Standard Reserved Current Strength Slew Rate Differential Par  ser Analog Seftings GXBVCCT_GXB\ ceiver¥O Pin Termi Dedicated Refck Pi Common Mode Drh inter Slew Rate & Differentiol Outpy
9 A
i feroeken Input PR_AF14 £ BIB_NO PR_AF14 25V 12mA (defaut)
% DRAM_ADORI12] Output PR_AJ14 8 B38_NO PR_AJ14 25V 12ZmaA (defout) 1 (defaul)
e DRAM_ADORI11] Output PR_AH13 B BI8_NO PI_AH13 25V 12md (defout) 1 (defaul)
& DRAM_ADOR{10] Output PR_AG12 38 BI8_NO PH_AGIZ 25V 12ma (defaut) 1 {dafaut)
% DRAM_ADOR{S] Output PR_AG13 k'S BIB_NO PRH_AGI3 25V 12ma (defaut) 1 (defaul)
% DRAM_ADORIE] Output PR_AH1S B B38_NO PR_AHIS 25V 12maA (defout) 1 (defaul)
% DRAM_ADORIT] Output PR_AF15 8 B38_NO PR_AF1S 25V 12m4 (defoul) 1 (defaul)
e DRAM_ADORIE] Output PR_AD14 B B38_ND PR_AD14 25V 12mA (Gefaut) 1 (derauR)
% DRAM_ADORIS] Output PBL_AC14 kS B38_NO PR_AC14 25V 12ma (defauk) 1 (defaul)
% DRAM_ADOR4] Output PR_AB1S k'S BIB_NO PH_ABIS 25V 12ma (defout) 1 (defaul)
% DRAM_ADORY] Output PR_AE14 B B38_NO PR_AE14 25V 12maA (defout) 1 (defauk)
%& DRAM_ADORI2] Output PR_AG1S k3 BIB_NO PH_AGIS 25V 12ma4 (defoul) 1 (defaul)
e DRAM_ADOR]1] Output PR_AH14 B B38_NO PR_AH 14 25V 12mA (defaut) 1 (defaul)
& DRAM_ADOR{0] Output PH_AK14 38 B38_NO PR_AK14 25V 12md (defaul) 1 (defaul)
Sa DRAM_BA[1] Output PR_AI12 £ BIB_NO PR_AI12 25V 12ma (defout) 1 (defaul)
% DRAM_BA[D] Output PR_AF13 B B3IB_NO PR_AF13 25V 12mA (defaut) 1 (defaul}
S DRAM_CAS_N Output PR_AF11 B BIB_ND PR_AF11 25V 12m4 (defaut) 1 (defaul)
‘e DRAM_CKE Output PR_AK13 B B38_NO PR_AK13 25V 12mA (defauk) 1 (defaull)
% DRAM_CLK Outpat PR_AH12 B B3B_NO PH_AHIZ 25V 12mA (defaut) 1 (defaul)
54 DRAM_CS N Output PR_AGH1 £ BIB_NO PR_AGH 25V 12ma (defauk) 1 (defaul)
'@ DRAM_DQ{15] Bidic PR_AJS B BIB_NO PR_AIS 25V 12mA (defaut) 1 (defaul)
& DRAM_DO[14] Bidic PR_AJE B BI8_ND PH_AJE 25V 12m4 (defout) 1 (defaul)
‘e DRAM_DQ[13] Bidic PRI_AHT k3 B38_N0 PR_AHT 25V 12mA (defauk) 1 (defaul)
Y DRAM_DO[12] Bidr PR_AHB B B38_NO PR_AHE 25V 12ma (cefaut) 1 (defaul)
% DRAM_DO(11] Bidr PR_AHS k' BIB_NO PR_AHY 25V 12ma (defaut) 1 (defaul)
i DRAM_DQ{10} Bidic PR_AJS 8 BIB_NO PH_AJS 25V 12mA (defaut) 1 (defaull)
' DRAM_DOS] Bidr PR_AJID B B38_ND PR_AJT0 25V 12ma (defout) 1 (defauR)
‘% DRAM_DQE] Bidir PR_AH10 B BI8_NO PR_AHIO 25V 12mA (defauk) 1 (defaul)
e =9 S = S S e e v
g £ >

0% 00:00:00



Questions
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